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1A - Important AC 5.3 SAP Notes

> Always apply the latest support packages for Access Control 5.3

> There are two types of AC 5.3 Support Packages:
A. For the AC 5.3 Application on NW AS Java 7.00 (cumulative) - SAP Note 1174625

B. For the NH (Non-HR) and HR RTAs in the backend (incremental) - Table listed on
next slide

> Content of all Support Packages is listed in the following notes:
RAR: 1168120
CUP: 1168508
ERM: 1168183
SPM: 1168121



1B - Important AC 5.3 SAP Notes (continued)

»>Patches for Non-HR and HR Real-Time-Agents (RTA's): Real Time Installation
VIRSANH and VIRSAHR comprise the RTA component)

NOTE NUMBER

DESCRIPTION

1138015 VIRSANH 530 46C Support Packages for 46C
1138109 VIRSAHR 530 46C Support Packages for 46C
1138016 VIRSANH 530 620 Support Packages for 620
1138020 VIRSAHR 530 620 Support Packages for 620
1138017 VIRSANH 530 640 Support Packages for 640 (ECC 500)
1138041 VIRSAHR 530 640 Support Packages for 640 (ECC 500)
1138018 VIRSANH 530 700 Support Packages for 700 (ECC 600)
1138042 VIRSAHR 530 700 Support Packages for 700 (ECC 600)
1270574 VIRSANH 530 710 Support Packages for 710
1270574 VIRSAHR 530 710 Support Packages for 710




2A — Download AC 5.3 Support Packages (JAVA)

SADd

Navigate ===> Support Packages and Patches ===> Entry by Application Group ==>
SAP Solutions for GRC ==>SAP GRC Access Control ===>SAP ACCESS CONTROL =—=>
SAP GRC ACCESS CONTROL 5.3 ===> JAVA Components

w | | O Advanced Search

my Profile  my Inbox  my Favorites Quick Links Sitermap Other Portals  Glossary Help

HOME Help & Support JEEEUIGELE Keys 8 Requests  Data Administration  Maintenance & Services  SAP Support Infrastructure . Release & Upgrade Info Knowled:

SAP Software Distribution Center  SAP Installations & Upgrades  SAP Support Packages  Business Objects Downloads Download Basket  Additig
You are here: Support Packages and Patches Feedbadk

* Support Packages and Patches

» Search for Support Packages and
Fatches

= Entry by Application Group

» Applications by Index

« My Company's Application Compaonents
» SAP Support Packages in Detail

= SAP Support Package Stacks m SAP Application Components = Plug-Ins

» Archive for Support Packages and m SAP Industry-specific Components m SAP Content

Patches m SAP MetWeaver m  Additional Components

» Database Patches (from other vendors) ] ]
m  SAP Business One m S5AP Development Projects

» Download Basket
m Adapters m SAP Education Products

Copyright  Privacy  Imprint m SAP Technology Components m SAP Solution Extensions by Partners

m Composite Applications m SAP Solutions for Governance, Risk and Compliance
m  Country-specific Add-Ons and Legal Changes m SAP BusinessObijects packages and products

m  Supplementary Components for Cross Industry Solutions m FUZZY! PRODUCTS
m SAP Frontend Components




» 7 Files to Download:

ware Distribution Center  SAP Instalations & Upgrades  SAP Support Packages  Business Ohjects Downloads — Database Patches t
JAVA-Components Feedback

SUPPORT PACKAGES AND PATCHES

Support Packages and Patches — SAP Solutions for Governance, Risk and Compliance— SAP GRC Access Control— SAP
ACCESS CONTROL — SAP GRC ACCESS COMTROL 5.3~ JAVA-Components

JAVA-COMPONENTS

SAP GRC ACCESS CONTROL 5.3 TXT
VIRACLP 530 700

= VIRAE 530 700

s VIRCC 530 700

n VIREPRTA 530 700

m VIRFF 530 700

= VIRRE 530 700




2C — Download AC 5.3 Support Packages (JAVA)

» Example of JAVA Download:

SAP. ‘ SUPPORT PORTAL

HOME  Help & Support JRESVTLST LS

I You are here:

my Profile  my Inbox  my Favorites

Keys B Requests  Data Administration  Maintenance & Services  SAP Support Infrastructure
S oftware Distribution Center  SAP Installati

# 05 independent

* Support Packages and Patches

» Search for Support Packages and
Patches

» Entry by Application Group

» Applications by Index

» My Company's Application Components
» SAP Support Packages in Detail

» SAP Support Package Stacks

b Archive for Support Padkages and
Patches

» Database Patches (from other vendors)
» Download Basket

| |a Advanced Sea

Quick Links  Sitemap Other Portals  Glossary F

Release & Upgrade Info  Know
Ad

pgrades  SAP Support Packages

Business Objects Downloads ~ Database Patches  Download Basket

Info Page

SAP GRC ACCESS CONTROL 5.3 TXT -> # OS independent

You can download one or more files by activating the chedk box on the left and dicking the button “Add to

Download Basket”. Please didk here for more detailed information. Clidk on m to request Side Effects
report.

Add to Download Basket Maintain Download Basket m Deselect All

The following objects are available for download:
File Type Download Object Title Patch Level Info File File Size [kb] Last Changed

SPO1 for

SAP GRC

ACCESS 0 Info 1207
CONTROL

5.3TXT

SPO2 for

—_— WIRACCMTRTA? M- SAP GRC

VIRACCMTMTOL 0-
10006535, 5AR

™ [i] sar 13.05.2008




3A - Download AC 5.3 Support Packages (RTA)

SADd

[ ] sdvanced search

my Profile ey Inbox my Favaorites GQuick Links ~ Sikemap  Other Portals  Glossary  Help
Ililili i Help & Support Downloads  Kews & Requests  Data Administration  Maintenance & Services  SAP Suppart Infrastructure Release & Upgrade Info Knowledge Exchange
I You are here: SAP GRC ACCESS CONTROL 5.3 Add To Favorites | Feedback

* SA4P Software Distribution Center

¥ Download

Support Packages and Patches

¥ Suppork Packages and Patches

= Search for Support Packages and Support Packages and Patchies~ SAP Solutions for Governance, Risk and Cormpliance— SAP GRC Access Control- SAP GRC ACCESS COMNTROL— SAP GRC ACCESS COMTROL

Patches

= Entry by Application Group . .

= Entry by Application Group {new) N aVIgate .

" Applkations by Index - Support Packages and Patche%

= My Company's Application . )

CorBens « JavA-Comporents - Entry by Application Group

» Archive for Support Packages and m RT4 on ERP 2005 .

Patches = RTA on ERP 2004 - SAP Solutions for GRC

= SAP Suppart Packages in Detail " E$i on EEE‘:IEB(;DF. 47200

= SAP Support Package Stacks : xpﬂcofr;r Oracie 9 SAP G RC ACCGSS COﬂthl

[l d d PAC for PeonleSoft
o e s andhreces . PACRI B - SAP ACCESS CONTROL
RTA on SAP BASIS 7.00 System
= Database Patches (fram other : RT& on SAP BASIS 6,40 System 9 SAP G RC ACC ESS CONTROL 5 _3
vendors) » RTA 0N SAP RF3 Enterpr. 47110
» 5AP Cryptographic Software = RTA0n SAP BASIS 6.20 Sustemn - <Choose your RTA>
» Preconditioned Product Version

= SAP Connectors

> Now choose your backend system

> Remember that ERP2005, ERP2004, R/3 Enterprise and R/3 4.6C require two
Real-Time Agents (RTA): VIRSANH and VIRSAHR. Both need to be patched
individually — starting with VIRSANH



3B - Download AC 5.3 Support Packages (RTA)
- Example: RTA on ERP 2005 SAR4

W | | O Advanced Search

my Profile ey Inbox my Favorites Cuick Links ~ Sitemap  Other Portals  Glossary  Help
I Help & Suppart Downloads  Kews & Requests  Data Administration  Mainkenance & Services  SAP Support Infrastructure  Relzase & Upgrade Info Knowledge Exchange
I You are here: ¥IRSANH 530_700 Feedback
¥ 5AP Software Distribution Center =

™ Dawinload Support Packages and Patches

* Support Packages and Patches

= Search for Support Packages and Support Packages and Patches— SAP Solutions for Governance, Risk and Compliance— SAP GRC Access Control— SAP GRC ACCESS COMTROL - SAP GRC ACCESS COMTROL
Patches 5.3 RTA on ERP 2005

= Entry by Application Group
= Entry by Application Group {nes
= Applications by Indesx

= My Company's Application RTA on ERP 2005

Companents = WIRSAHR 530 700
» Archive for Support Packages and n YIRSANH @_?DD
Patches

= SAP Support Packages in Detail
= SAP Support Package Stacks Info Page ol 1EDE

» Installations and Upgrades

» Conkenk

= Database Patches (from other YIRSANH 530_700

vendors)

= SAP Cryptographic Software

= SAP Conmeckors I] Al corrective software packages, for SAP MetWeaver 20045 and SAP Business Suite 2005 and beyond that are delivered after April 2nd, 2007 will DMLY be
o G iy o Ceheamies available via SAP Solution Manager's Maintenance Cptirmizer, Find more details here,
= Ordering SAP-Software
o Eanmled Beglah You can download one ar more files by activating the check box on the left and clicking the button "Add to Download Basket™, Please click here for more

o il it Sl detaled information. Click on [ ta request Side Effects repart.

Copyright  Privacy  Imprink
Add to Download Basket Maintain Download Basket m Deselect all

The following objects are available for download:

File Type Download Dbject Title Info File File Size [kb] Released On
SAPK-
E e is] 05,
T [ ser IV IREANH VIRSANH 530 700: patch 0001 Info 998 06.05.2008

Add to Download Basket Maintain Download Basket m Deselect All




4 - AC 5.3 Java Components to be Patched

» The following Java components are patched with Support Packages :
Risk Analysis and Remediation (RAR) - VIRCC 530 _700

Compliant User Provisioning (CUP) - VIRAE_530 700
Enterprise Role Management (ERM) - VIRRE_530 700
Superuser Privilege Management (SPM) - VIRFF_530_700
Access Control Launchpad (ACLP) - VIRACLP_530 700

» The Netweaver Portal Real-Time Agent is also patched with a Support Package:
Enterprise Portal Real Time Agent (EPRTA) - VIREPRTA 530 700
To be applied to the Netweaver AS Java that is hosting the Netweaver Portal

The Java Files are .SCA Files which are the archive files of the .SCA Files. The SCA
Files have been zipped, again, causing the file to have .SCA.ZIP extension. This file
cannot be extracted or unzipped to an installable .SCA format. Please rename these
files to .SCA by removing the .ZIP extension



5 — Deployment of the Current Version of AC 5.3
- SAP Note 1174625 and SDM E_.E.';y

> Please refer to SAP Note 1174625 on how to apply the Support Packages for the
AC 5.3 Java Application Components

> Applying Support Packages (or ,patching®) to Java Application Components
means that a support package contains the entire Java Application Component in its
latest version (Cumulative Suppport Packages)

» Log-on with <SID>adm user on the operating system level of your AC 5.3 server
and start the SDM (Software Deployment Manager)

> Logon to SDM using the SDM password (which is different than the passwords of
the ,Administrator and <SID>adm users)



6A — Deployment of SP Java Components
- The Java Support Package Manager SAR4

» The deployment of the Java Support Packaged Components is done with the
JSPM (Java Support Package Manager)

» On your AC 5.3 server copy the AC 5.3 Support Packaged .SCA Files to the
folder /usr/sap/trans/EPS/in/

» The JSPM is a tool that works similar to SDM and has to be started from the OS
level of the server as user <SID>ADM from /usr/sap/<SID>/<CI>/j2ee/JSPM/go.bat
(Windows) or .../go and .../StartGui (Unix).

» The .SCA File sap.com/VIREPRTA containing the RTA for the Netweaver Portal
EP7.0 SP12+ is deployed to all your Netweaver Portal 7.0 servers in scope of your
implementation. Don‘t deploy it onto your AC 5.3 server unless you run a
Netweaver portal on the same server, as well.



6B — Deployment of SP Java Components
- Logon to JSPM with SDM Password

Help  Info

Log On

Log an to the system

Log an with 50 password

SDM Password

Before starting the patch process, we recommend that wou review 5P User Guide and 4P Mote 89159832 first.

[ Log On || Exit

|JSPM data model has already been initialized.




6C — Deployment of SP Java Components
- Select Package Type SAD4

Deplovwed Companents i Logs

FEi ' | '
2E2 = i | -
Select Package Type Specify Queue Zheck Queue Deployw Queue Completed

Select a package type and an FHWDl swstem role

To appl a support package stack, we recammend that wou select the "Support Package Stack” indicator. Otherwise wou
may inconsistently update wour system.For more information, see SP Stack Quide and AP MNote 884527,
For recommended Jawva WM settings, see AP Mote 722905,

The Inbox directory is fusrfsapftrans fEPS/Sin.
Select a package type 1o apply

) Support Package Stack
) |awa Support Package Manager (ISP M)
O single suppor Packages (advanced use)

(2 Business Packages fadwvanced use)
i) Install Additional Usage Twpoe (adwvanced use)

Select whether the system is under BWDI control and the respective RWDI system role
MWD Control

@ Mo MWDl control
O DEY

O ComMs

O TEST

) PROD

| Back I PE T 1] Cancel |

Select Package Twpoe

If no AC Components are found under “New Software Components”, please try “Business Packages”



6D — Deployment of the SP Java Components
- SKip the EPRTA Components

e, SAP - Software Delivery Tools GUI
Helg  Info
Deploviment
b ng |
Select Package Tywie Specify Queue Check Queue Deploy Quele Campleted
New Software Components > Specify Queue
Select new software components to deploy
Select newy software Compaonents to deploy
Wendor/hame Target Felease 3PLewel PatchlLewvel Dietails
gap.com/YIRACLP S30.700.1.0 g Show Details
sap.comdWIRAE o30.700.1.0 el Showe Details
sap. camd WIRCE 930 FER 1.8 B Showe Details
gap.com/YIREPRTA S30.700.1.0 B Show Details
sap. comiWIRFF 230.700.1.0 B Show Detajls
sap. camdWIRRE 930 FAR 1.8 Eif Showe Details
Select news software compaonents 1o deploy
YWendor/Mame Target Eelease. 5FLewel PatchlLewvel Dietails
sap.com/WIRACLP 230, R 1.0 El Show Details
sap.com!/YWIRRE o30.700.1.8 EI! Show Details
sap.com!WIRGE ] O 1 I R O EI| Show Details
sap . com/VIREPRTA skip = Show Details
sap.com!YWIRFF 230, 701,08 Ell Show Details
sap.com!/YIRRE o30.700.1.8 EI! Show Details
L3
| Back I I Mext I| cancel I

lScan of Inbox has finished.




6E — Deployment of the SP Java Components
- Check Queue and Confirm

SAP - Software Delivery Tools GUI

.
, (2] (3] [4] g
Select Package Tywpe Specify Queue Check Queue Deploy Quele Completed
New Software Components > Check Queue
walidation of the dependencies of the selected software components
J2EE Engine will be restarted during deployment if there are Portal applications to be deployed
The following software components will be deploved:
Qrder  Wendarfhame Current Eelease SFLevel Patchlewel |Target Release 5PLewel Patchlewel |Status Cietails
1 sap. com/YWIRLCLP 230,760,108 0K Showe Detail
2 sap.com!WIRAE 030.700.8.0 230.7060.1.0 0K Show Detail
3 sap.caom!WIRGE 030,700 8.0 30 706 .1.@ 0K Shove Detail
4 sap.com!WIRFF 530.700.8.0 530.7060.1.0 0K Showe Detail
a sap.com!YIRRE o30.700.68.0 o30.700.1.0 0K Show Detail
3
[ [ []
| Back II STar I | Cancel
walidation of selected components has finished.




6F — Deployment of SP Java Components
- Completed Deployment

SAP - Software Delivery Tools GUI

Deployment

e

e

Select Package Typoe Specify Queue Cheu: Qeue Deplay Queus Completed
New Software Components > Completed

Deployment of software components has finished

To wiew some statistics for wour patch procedure and to send wour feedback to 3AP, open the following Ewaluation Form,
You can find the BEvaluation Form in the jusrfsapfallfjcolfj2eef[5PMflog/log_ 2008 _05_ 27 _04_05 55/ lspmEesults html

file.

Ceplosanent of software compaonents has finished

Qrder |\fendnr;Name 0Old Feleasze. 5P Lewel.PatchLevel |(Current Eelease.SPLewvel Fatchlewel |Status Details

1 |sap.comVI. .. 530.700.1.0 DEFLOYED [Show Details)
2 |sap.com/YIRAE |530.700.0.0 530.700.1.0 DEPLOYED [Show Details]
3 sap.com/YIRCC |530.700. 0.0 o30.700.1.0 DEFLOYED |Show Dietails)
4 sap.com/VIRFF [530.700.0.0 o30.700.1.0 DEFLOYED |Show Dietails)
a sap.com/YIRRE |930. 700 6.0 o30.700.1.0 DEPLOYED |Show Details

| Back || Mew Deployment |

|Deplument has finished.




7 — Check the New AC 5.3 Version

SAP GRC Access Control
Risk Analysis and Remediation

AR, Rule Architect | Mitigation . Alert Monitor , Configuration ;| Debugger ; Analysis Daemon

Welcome Frank Bannert

Help | About | Logout

.11;

¥ )

HEE

~ Management View
* Users Analysis
* Role Analysis
* Comparisons
* Alerts
* Rules Library
* Control Library
* Risk Analysis
* Audit Reports
» Security Reports
* Background Job

Month/Year

System

Management View - Risk Violations
Risk Violations

05/2008 I~

Al

|v|
|

TR

Summary as of 07-May-2008

Analysis | About

User Gro w

Violation

Version:

Number ¢

Total Mur i
Risk Viola

SAP GRC Access Control
Risk Analysis and Remediation

AC-RAR 53 01.0

20240408

Technical Support: To report technical issues for SAP GRC Access Control, please create a support message

through the SAP Support Portal under the following component (S-User access is required):
GRC-5CC - Risk Analysis and Remediation (formerly known as Virsa Compliance Calibrator)

Basis Copyright:£2002-2008 SAP AG. All Rights Reserved.

Finance
HR and F
Materials

Procure to Pay
Order to Cash

135,166 25%

79,313

|
?931'3@4

15%




8 — SP Java Post-Installation Steps for RAR

SADd

> Upload the initial data files which are packaged with the SP’s. For RAR, please check SAP
Note 1168120 regarding RAR post-installation steps.

> Importing Error Messages (CC5.3_ MESSAGES.txt):

> You will need to import the error message file as part of post-installation for AC 5.3 SP’s:
a. Copy the CC5.3_ MESSAGES.txt to the local directory
b. Login into Risk Analysis and Remediation
c. Import them into AC using the option: Configuration -> Ultilities -> Import

v AN . . . .
t_-_/ Risk Analysis and Remediation Welcome Shiela Mangravito Help  About  Logoff
Informer ;  Rule Architect , Mitigation , Alert Mnninr Analysis Daemon |, Help Guide

E D iEn T iEs i Import Configuration
= Mitigating Controls
= Workflow Local File: | || Browse. ..
= Miscellansous

Import Configuration

* MIC User Mappings
* MIC Rizk Mappings
» Connectors
* Logical Sy=stems
F Cross Sy=tems
» Data Extraction
= Master User Source
* Usesr Mapping
» Custom User Groups
» Upload Objects
* Rule Upload
» Backend Sync
» Background Job
= Organizational User M- pping
= Custom Tabs
= SAP Adapter
~ Ltilities
I

S e Vs -




OA - SP Java Post-Installation Steps for CUP

SADd

> 1. Upload the initial data files which are packaged with the SP’s. For CUP, please check
SAP Note 1168508 for CUP post-installation steps:

1. Copy the AE _init_clean_and_insert_data.xml to the local directory

2. Login into Compliance User Provisioning

3. Go to menu, Configuration -> Initial System Data

4. Select AE_init_clean_and_insert_data.xml from the location where you

copied the file
5. Select the 'Clean And Insert' radio button
6. Click Import

SAP GRC Access Control
Compliant User Provisioning

Welcome Shiela

My Work Informer Configuration
= End User Personalization = Initialize DB
= Support

Import Data
» WWorkflow

File Mames
F Reque=st

Browse

» Field Mapping [ Insert
F Approvers — Appeng
F User Rewiew

» Change Log Lo Clean and Ingrt

Import

Export ".ata

» Connectors

= Authentication

= User Data Source
» HR Trigger

» Roles

= Background Jobs

ame Description

Initial Drata Initial Drata
F User Defaults

Connector Connector
= Attachments
» Monitoring Roles Roles

= Mizcelaneous

Initial Sy=stem Data

= Upgrade

000030 M

Wworkflow Configurati

U=ser Defaults

Hr Triggers

n Workflow Configuration

U=ser Defaults

Hr Triggers



9B - SP Java Post-Installation Steps for CUP

> 2. Upload the initial data files which are packaged with the SP’s.

SAP Note 1168508 for CUP post-installation steps.
1. Copy the AE_init_append_data.xml to the local directory
2. Login into Compliance User Provisioning
3. Go to menu, Configuration -> Initial System Data
4. Select AE_init_append_data.xml from the location where you copied the file

5. Select the 'Append' radio button
6. Click Import

Informer

Compliant User Provisioning

Configuration

= End U=ser Per=sonalization
= Support

F Workflow

» Request

b Field Mapping

F Approwvers

b User Review

» Change Log

» Connectors

= Authentication

= User Data Source
» HR Trigger

» Roles

= Background Jobs
» U=ser Defaults

= Attachments

F Monitoring

= Mizcellansous

| wior SystemDota |

Hnmrade

-

~
=
—

i jjfin |injjnifu]

= Initialize DB

Import Data

File Name

Insert
Apper

Clean agf Insert

Import

Exp ort Data

Mame

Initial Data

Connector

Roles

Workflow Configuration
User Defaults

Hr Triggers

SADd

For CUP, please check

Welcome Shiela

Browse. ..

Description

Initial Data
Connector

Roles

Workflow Configuration

User Defaults

Hr Triggers



9C - SP Java Post-Installation Steps for CUP

SADd

> 3. Upload the initial data files which are packaged with the SP’s. For CUP, please check
SAP Note 1168508 for CUP post-installation steps.

1. Copy the AE_init_append_data ForSODUARReview.xml to the local directory
2. Login into Compliance User Provisioning
3. Go to menu, Configuration -> Initial System Data

4. Select AE_init_append_data_ForSODUARReview.xml from the location where
you copied the file

5. Select the 'Append' radio button

6. Click Import el Compliant User Provisioning Welcome Shiela
My Work Informer Confgguration
= End U=ser Personalization = Initialize DB
= Support Import Data
» Vorkflows File M
» Request lle Namg Browse...

» Field Mapping [ Insert

F Approvers = apsfnd
F User Review

» Change Log [ fliean and Insert
F Connectors
Ifport

- Authentication _Inort |
= U=er Data Source
» HR Trigger Export Data
> Roles T Mame Description
= Background Jobs Initial Data Initial Data
F User Defaults

Connector Connector
= Attachments
F Monitoring Roles Roles

Mizcellansous Workfloww Configuration Workflow Configuration

miin}in/jn}in|ln

User Defaults User Defaults

Hr Triggers Hr Triggers

-



9D - SP Java Post-Installation Steps for CUP
Required to be Configured Only if CUP Uses RAR El-;y

> 4. Upload the initial data files which are packaged with the SP’s. For CUP, please check

SAP Note 1168508 for CUP post-installation steps. Please refer to SAP Note 1157209; in
accordance with that note, import the files as follows:

a. Copy the AE_init_append_data CC.xml to the local directory

b. Login into Compliance User Provisioning

c. Go to menu, Configuration -> Initial System Data

d. Select AE_init_append_data_CC.xml from the location where you copied the file
e. Select the 'Append' radio button

f. Click Import w SAP GRC Access Control
Compliant User Provisioning Welcome Shicla |
oy v o

= End User Per=onalization = Initialize DB

= Support Import Data
b Workflow
File Mame AE_init_append_data_ CiC.xml Browse ...
F Request
» Field Mapping i Inzert

r Approvers — Append

» U=zer Review
b Change Log i Cleayfl and Insert
» Connectors
ImpclrtJ
= Authentication —
= User Data Source
» HR Trigger L EEGE 1T
» Roles ™ mMame De=scription
= Background Jobs I | nitial Data Initial Data
F User Defaults
P— - I Connector Connector
- achmen
» Monitoring I Roles Roles
_— T wWorkflow Configuration Workflow Configuration
=er Defaults ser Defaults
— |u Default L Default
I HrTriggers Hr Triggers



OE - SP Java Post-Installation Steps for CUP

SADd

> 9. Currently, after installing the support pack, please make sure you click on the Upgrade
button in Configuration - Upgrade screen to complete the installation. This step can be
ignored if the button is disabled.

L Compliant User Provisioning

s AT

“ Upgrade

* End User Personalization
= Support

P Workflow

F Request

F Field Mapping

F Approvers

F User Review

F Change Log

b Connectors

= Authentication

» U=er Data Source
F HR Trigger

} Roles

« Background Jobz
b User Defaults

= Attachments

F Maonitoring

= Mizcellansous
= Initial Swstem Nata



> 1. For SPM, please check SAP Note 1168121 for SPM post-installation steps.
» Currently: None



11A - SP Java Post-Installation Steps for ERM

SADd

> 1. Upload the initial data files which are packaged with the SP’s. For ERM, please check
SAP Note 1168183 for ERM post-installation steps

1. Copy the RE_init_clean_insert_data.xml to the local directory

2. Login into Enterprise Role Management

3. Go to menu, Configuration -> Initial System Data

4. Select RE_init_clean_insert_data.xml from the location where you copied the file
5. Select the 'Clean And Insert' radio button

6. CIle Import | P g Enterprise Role Management Welcome Shiela Mangravito

Role Managemesnt Informer Configuration
= Custom Fields “ Import Data
= Project/Releasze File Name Browse...

= Role Status

= Naming Conwention O insert

» Org. Value Mapping & Appknd

= Condition Groups i# Jllean and Insert

F Methodology

P System Landscape Import

» Workflow

¥ Log History

= Background Jobs
= Mizcellaneous

= Tranzaction Import
= Kass Role Import

D05 Tyachoon zation

Vs sysiemoma |

= eI LA L



11B - SP Java Post-Installation Steps for ERM

SADd

> 2. Upload the initial data files which are packaged with the SP’s. For ERM, please check
SAP Note 1168183 for ERM post-installation steps

1. Copy the RE_init_append_data.xml to the local directory

2. Login into Enterprise Role Management

3. Go to menu, Configuration -> Initial System Data

4. Select RE_init_append_data.xml from the location where you copied the file
5. Select the 'Append' radio button

6. Click Import w SAP GRC Access Control

Enterprise Role Management VWelcome Shiela Mangravito

Role Managemesnt Informer Configuration

= Custom Ficlds “ Import Data

0 FLERLREETEE File Name Browse...
= Rols Status
= Maming Conwention  ipfert
= Org. Value Mapping * 4 Append
= Condition Grou 4

= - Clean and Insert

P Methodology
P System Landscape Import
P Workflow
P Log History

= Background Jobs

= Mizcellaneous

= Tranzaction Import

= Mas= Role Import

' Rue usage syncnn nization

[ | initial SystemData | |

= Lonnguration Semngs



11C - SP Java Post-Installation Steps for ERM

SADd

> 3. Upload the initial data files which are packaged with the SP’s. For ERM, please check
SAP Note 1168183 for ERM post-installation steps

> 1. Copy the RE_init_methodology data.xml to the local directory
2. Login into Enterprise Role Management
3. Go to menu, Configuration -> Initial System Data
4. Select RE_init_methodology data.xml from the location where you copied the file
5. Select the 'Append' radio button

6. Click Import w SAP GRC Access Control

Enterpriﬁe Role Management VWelcome Shiela Mangrawito
-
= Custom Fields “  Import Data
° FILERLTEEEEE File Narmne Browse...

= Role Status

= Maming Conwention
= Org. Value Mapping [ Apgfend
= Condition Groups

i Insert

= 4Llean and Insert
» Methodology
P Sy=tem Land=zcape Import

P Workflow

» Log History

= Background Jobs

= Mi=cellaneous

= Transaction Import

= Mazs= Role Import

» Role Usage Synchr nizet an

I Initial Sy=tem Data _

= Configuration Settings



11D - SP Java Post-Installation Steps for ERM
Required to be Configured Only if CUP Uses ERM E;y

> 4. Upload the initial data files which are packaged with the SP’s. For ERM, please check SAP
Note 1168183 for ERM post-installation steps

> 1. Copy the AE_init_append_data_ RE.xml to the local directory
2. Login into Compliance User Provisioning
3. Go to menu, Configuration -> Initial System Data
4. Select AE_init_append_data RE.xml from the location where you copied the file
5. Select the 'Append' radio button

6. Click Import w SAP GRC Access Control

Compliant User Provisioning Vielcome Shiela Mangravito

K Work Informer Copgfiguration

- Self Service =  Initialize DB

= Us=ser Registration Import Data

= Cu=stom Fields
Fil= Nams Browse...

= End User Personalization
= Support [ I oert

» Workflow

F Reguest

F Field Mapping [ Clefin and Insert

=  Appedd

F Approwvers

P User Rewview ﬂrJ

¢ Change Log

» Connectors - fEml 1T

= Authentication —  MNames Description

= U=ser Data Source

I  Initial Data Initial Drata
F HR Trigger
I Connector Connector
F Roles
= Background Jobs I | Roles Roles
F User Defaults I~  Workflow Configuration Workflow Configuration
= Atftachments I | User Defaults User Defaults
L LrmizTaa I  Hr Triggers Hr Triggers

= Mizcellansous




11E - SP Java Post-Installation Steps for ERM

SADd

> 5. Currently, after installing the support pack, please make sure you click on the

Upgrade button in Configuration - Upgrade screen to complete the installation.
This step can be ignored if the button is disabled.

v AN T ———— TR ML RERRT T R TR R e T ————
h—-—" Enterprise Role Management

ym— —

= Custom Ficlds “  Upgrade

= Project/Relsase
= Role Status

| current werstbnds.z

. (3
= Maming Conwvention I New \sfsiopls.2

= Org. YWalus Mapping
 Soonen oo teareas/|
P Sy=tem Land=scape

P Workflow

P Log History

= Background Jobs

= Miscellansous

= Tran=saction Import

= Kas= Role Import

= Role Usages Synchronization
= |nitial Sy=tem Data

= Configuration Settings

» Administration

B Minratinn fromm 4 0

| _Upgrade I -



12 - SP Java Post-Installation Steps for Enterprise
Portal RTA

SADd

» 1. For Enterprise Portal RTA, please check SAP Note 1168710 for Enterprise
Portal RTA post-installation steps.

Currently: None



13 - SP Java Post-Installation Steps for AC 5.3
Launch Pad

SADd

1. For AC 5.3 Launch Pad, please check SAP Note 1168691 for AC 5.3 Launch
Pad post-installation steps.

Currently: None



14 - Upload RTA Patches
-2 Transaction SAINT E;y

» On your backend system copy patch files for Non-HR (and HR, if necessary) RTA
downloaded from SMP into the directory /usr/sap/trans/EPS/in

> In client 000, start Transaction SAINT, click on ,Load"“ and ,Confirm*

Add-On Installation Tool - Version 7.00/0026
El=]

SAINT: Uploading Packages from the File System

Add-0On Installation Tool: PCS package selection
.E @ 2 - OCS File N |Pack |Resu] Rrcfm Text
ﬂﬂﬁl EFGS = e e 5 T e Mame ackage Bsu e553age &
T ;’admgsmﬁwsﬁm_ _ CSNO120061532_0030637 PAT| SAPK-53301INVIRSANH | oo@ | 0000 |Uploaded successfully
PC3 |Release  |Description |Package typelT] CSN0120061532_0030641.PAT SAPK-53301INVIRSAHR | co@ 0000 Uploaded successfully
Mo Installation Packaages are available |_|
[= SAINT: Confirm upload

| The EPS inbox is located under the following
= | path: fusrisapftrans/EPS/in

— + Do you want to upload OCS Packages from the ERP=
1 inbox?

IL?)
[ Yes §|T|

Select a package from the installabl’ R CS packages
- Choose [CONTIMUE] to start the calculati 'n of the installation queue
- Choose [BACK] to go back to the overview o fthe installed Add-ons
- Choose [LOAD] to load additional packages rom the application server

Status/Remarks -~

[E Back |[B  continue ||[@ Load Screen 1/4




15A - Apply Patch for Non-HR RTA
- Transaction SPAM: Define Queue

> Logon to Client 000

> Start Transaction SPAM, select the VIRSANH_530_ 700 Patch and click on ,Queue*

OCS Package Directory: New Packages

- % queue || By Package Attributes ||_@! Link| [ Legend|

QS packages available for this system'Description |Stat___ |Imp0rl Status

SAP GRC Access Controls 5.3 for 700 HR 5

= @ VRSAHR_ SAP GRG Access Conlrols 53 o .
] ﬁ SAPK-53301INVIESAHFE. VIRSAHR 530_700: patch 0001 OO Motimported
< @ VIRSANH SAP GRC Access Controls 5.3 for 700 HR 2

I € SAPK-53301IN IRSAH VIRSANH 530_700: patch 0001 QMO Notimported

OCS Package Directory: New Packages

[ Define Queul for tt'e Add-On VIRSANH rel. 530_700

Choose the high:st Support Package you want or confirm |E Queue ||EEE Package Aftributes ||ﬁ Li”k| Legend|

OCE packages available for this system |Descripti0n

[stat [import Status

Component |Release

Short Description @ VIRSAHR
[ ﬁ SAPK-53301INVIRSAHR
= VIRSANH
= ﬁ SAPK-53301IMYVIRSANH
= (3 Prerequisite set01
B VIRSAMNH 530_700

Package (D

530_700 VIRSANH 530_708:

SAPK-£ 43017 d. .| VIRSANH

[05T/

SAP GRC Access Controls 5.3 for FTO0HR S
VIRSAHR 530_700: patch 0001
SAP GRC Access Controls 5.3 for TOOHR a
VIRSAMNH 530_700: patch 0001

QMO Motimported
C¥¥D  Motimported

v

vilE 3@l

llI?f’ Display Queue for the Add-On VIRSANH rel. 530_700

Short Description

VIRSANH 530_706: patch 0001

Package ID Component |Release
% SAPK-53301IN. | VIRSANH 530_700
[0

[<1[¥]




15B - Apply Patch for Non-HR RTA
- SPAM: Import 1 (ABAP Dictionary Objects)

SADd

> Confirm to start the import of ABAP Dictionary Objects

> If you modified Objects you have to run in Transaction SPDD a ,Modification Adjustment®.
Each customer has to decide if the modifications are still needed

> If you just Confirm Adjustment, all Objects will be recovered back to SAP Standard

Information on Modified Objects

Support Package Manager - Version 7.00/0026

(& Call SPDD | & Confirm Adiustment |
@

Phas¢ RUN_SPDD_7?: Information on Objects Modified in System

Queue ;IS'API'('—-SQSIB"{: |‘? Display/define

The ABAP Dictionary objects were imported completely. This means that
@ | all imported ABAP Dictionary objects are now available in your system

N= sPaM: import Queue

inthe shipped original state.
5 ! . : The system detected however that 6 of the ABAP Dictionary objects

Direct I::nggige SAPK-53301INVIRSANH will now be imported gfCcording to scenar in the SUDDDT'C PEICKEIQES have heen modified in your system.
) e
{7V Abt Check whether you want to retain or restore the changes you have made.
To avoid known problems, first read SA9 Note 822370 "Known problems wi = 2 ' '
& Support Packages in SAP N 20845 AS/ABAP" . To do this, call transaction 3SPDD (choose 'Call SPDD').

The queue will now be importp® with the following start options for th For more information about performing the modification adjustment, see
@ individual modules: "Modification Adjustment Help'.

Preparation: ﬁ? Start in dialog

Import 1: = Continue in dialog Note:

Import 2: = Continue in dialog IT you do not perform a modification adjustment, all the changes to the

S OB Ep otk aldiog objects named in transaction SPDD are lost after Dictionary activation.

If you have modified tables, this may lead to data being lost.
v |6€{’ Note ||@@ Start options | llIrr'Conﬁrm Completion of Modification Adjustment

|s modification adjustment of the Dictionary
ohjects complete?




15C - Apply Patch for Non-HR RTA
- SPAM: Import 2 (Repository Objects) SARZ

> Confirm to start the import of ABAP Repository Objects

> If you modified Repository Objects you have to run in Transaction SPAU another
,Madification Adjustment”. Each customer has to decide if the modifications are still needed

> If you just Continue, all Objects will be recovered back to SAP Standard.

Support Package Manager - Version 7.00/0026
Information on Modified Objects

(& callsPaU |[8] Continue |
IE?' SPAM: Import Queue
Phase RUN_SPAU_?: Informaticn on Objects Modified in System
The gqueue SAPK-53301INVIRSANH will now be continued according ta The import was completed successfully. This means that all the
scenario Standard with phase RUN_SPDD_?. Repository objects that were imported are now activated in the shipped
original state.
go E'mekn:""n pmm;:;=N£ESSB§APA20;§A§E23?Q "Known problems with i The system detected however that 57 of the Repository objects in the
Hgening Fediieg B = : Support Packages have been modified in your system

The queue will now be imported with the following start options for the

remaining modules: Check whether wou want to retain or restore these changes you have made.

To do this, call transaction SPAU (choose 'Call SPAU').

Import 1: & start in dialeg
Import 2: =p Continue in dialog For more information about performing the modification adjustment, see

Clean Up: = Continue in dialog ‘Modification Adjustment Help'.

If you want to continue importing the queue immediately, choose
"Continue’ .

| G Note ||@: Start options |




| Support Package Manager - Version 7.00/0026 |

Queue [SAPK-53301] (%%  Displayidefine |




16A - Apply Patch for HR RTA
- SPAM: Define Queue for HR-RTA Patch E‘?

» Patching the VIRSAHR Real-Time Agent is only required if this RTA is installed
on the backend system. This is only the case if your backend is ERP2005,
ERP2004, R/3 Enterprise, or R/3 4.6C. In other cases, this step is skipped.

> Select the VIRSAHR 530 700 Patch (here: Patch 0001 belonging to AC 5.3
SPO01) and run the exact same steps as in VIRSANH 530 700, again.

OCS Package Directory: New Packages
|E Queue ||E"EE| Package Attributes |||ﬁl Link| | Legend|

C3 packages available for this system IDescriptinn |Stat___ |Impnrt Status
= @ ‘-II_RSAHR SAP GRC Access Controls 5.3 for YOO HR 3

[ @ SAPKE-53201INVIRSAHR VIRSAHR 530_700: patch 0001 YD Mot imported
I@Deﬂng Queue for the Add-On VIRSAHR rel. 530_700

Choose the highest Support Package you want or confirm the queus

Package ID Component |Release short Description

SAPK-53301IN. . | VIRSAHR 530_7a0a VIRSAHR 530_700: patch 0091

alD| [<0]




| Support Package Manager - Version 7.00/0026 |
BEEEG




17 - Check Updated Patch Levels in SPAM

SADd

» Check updated patch levels of VIRSANH (and VIRSAHR) RTA in Transcation

SPAM.

» If you‘ve upgraded from the previous AC 5.2 release, and previously installed

VIRSANH_ 520 700 (and VIRSAHR_520 700) RTAs, then the following screen is
displayed in transaction SPAM:

o=

VIRSAHR
SAPK-52301INVIRSAHR
SAPK-52302INVIRSAHR

(p
@
€ SAPK-52303INVIRSAHR
@
=)

SAPK-52304INVIRSAHR

SAPK-53301INVIRSAHR
VIRSANH
€ SAPK-52201INVIRSANH
& SAPK-52202INVIRSANH
6P SAPK-52303INVIRSANH
&P SAPK-52304INVIRSANH
€ SAPK-52205INVIRSANH
& SAPK-53301INVIRSANH

vvvvvv.@vvvvv=@

SAP GRC Access Controls 5 3 for 700 HR 5

VIRSAHR 520_700: Patch 0001
VIRSAHR 520_700: Patch 0002
VIRSAHR 520_700: Patch 0003
VIRSAHR 520_700: Patch 0004
VIRSAHR 530_700: patch 0001

: SAP _I:_BRC Access Cnn_trn_ls_ 5_._3 ﬂ:ufTr‘Ell;l I_—|R a
VIRSAMNH 520_700: Patch 0001

WIRSAMNH 520_700: Patch 0002
VIRSAMNH 520_700: Patch 0003
VIRSAMNH 520_700: Patch 0004
VIRSAMNH 520_700: Patch 0005
WIRSAMNH 530_700: patch 0001

Imported on 20.11.2007 at 15:43:52
Imported on 20.11.2007 at 15:43:53
Imported on 20.11.2007 at 15:43:54
Imported on 20.11.2007 at 15:43:55
Imported on 27.05.2008 at 04:38:13

Imported on 20.11.2007 at 15:34:36
Imported on 20.11.2007 at 15:34:37
Imported on 20.11.2007 at 15:34:38
Imported on 20.11.2007 at 15:34:39
Imported on 20.11.2007 at 15:34:40
Imported on 27.05 2008 at 04:35:54



18 - GRC RIG Contact & More Information

» GRC Regional Implementation Group
SAP BusinessObjects Governance, Risk, and Compliance Solutions

SDN / BPX: https://www.sdn.sap.com/iri/bpx/grc

E-mail: grc rig@sap.com



https://www.sdn.sap.com/irj/bpx/grc
mailto:grc_rig@sap.com

Comments and Accelerator Feedback

SADd

Your feedback is very valuable and will enable us to improve our
documents. Please take a few moments to complete our feedback form. Any
information you submit will be kept confidential.

> You can access the feedback form at:

http://www.surveymonkey.com/s.aspx?sm=stdoYUIaABrbKUBpE95Y9qg 3d 3d



http://www.surveymonkey.com/s.aspx?sm=stdoYUlaABrbKUBpE95Y9g_3d_3d

	SAP GRC RIG �Access Control 5.3�How to Apply Support Packages in AC 5.3��Updated: June, 2009
	Content
	1A – Important AC 5.3 SAP Notes
	1B - Important AC 5.3 SAP Notes (continued)
	2A – Download AC 5.3 Support Packages (JAVA)
	2B – Download AC 5.3 Support Packages (JAVA)
	2C – Download AC 5.3 Support Packages (JAVA)
	3A – Download AC 5.3 Support Packages (RTA)
	3B – Download AC 5.3 Support Packages (RTA)�	 Example: RTA on ERP 2005
	4 – AC 5.3 Java Components to be Patched
	5 – Deployment of the Current Version of AC 5.3�	 SAP Note 1174625 and SDM
	6A – Deployment of SP Java Components�	 The Java Support Package Manager
	6B – Deployment of SP Java Components�	 Logon to JSPM with SDM Password
	6C – Deployment of SP Java Components�	 Select Package Type
	6D – Deployment of the SP Java Components�	 Skip the EPRTA Components
	6E – Deployment of the SP Java Components�	 Check Queue and Confirm
	6F – Deployment of SP Java Components�	 Completed Deployment
	7 – Check the New AC 5.3 Version
	8 – SP Java Post-Installation Steps for RAR
	9A – SP Java Post-Installation Steps for CUP�
	9B – SP Java Post-Installation Steps for CUP
	9C – SP Java Post-Installation Steps for CUP
	9D – SP Java Post-Installation Steps for CUP  Required to be Configured Only if CUP Uses RAR 
	9E – SP Java Post-Installation Steps for CUP�
	10 – SP Java Post-Installation Steps for SPM�
	11A – SP Java Post-Installation Steps for ERM�
	11B – SP Java Post-Installation Steps for ERM
	11C – SP Java Post-Installation Steps for ERM
	11D – SP Java Post-Installation Steps for ERM� Required to be Configured Only if CUP Uses ERM 
	11E – SP Java Post-Installation Steps for ERM
	12 – SP Java Post-Installation Steps for Enterprise Portal RTA�
	13 – SP Java Post-Installation Steps for AC 5.3 Launch Pad��
	14 – Upload RTA Patches�	 Transaction SAINT
	15A – Apply Patch for Non-HR RTA�	 Transaction SPAM: Define Queue
	15B – Apply Patch for Non-HR RTA�	 SPAM: Import 1 (ABAP Dictionary Objects)
	15C – Apply Patch for Non-HR RTA�	 SPAM: Import 2 (Repository Objects)
	15D – Apply Patch for Non-HR RTA�	 SPAM: Completion of Non-HR RTA Patch
	16A – Apply Patch for HR RTA�	 SPAM: Define Queue for HR-RTA Patch
	16B – Apply Patch for HR RTA�	 SPAM: Completion of HR RTA Patch
	17 – Check Updated Patch Levels in SPAM
	18 - GRC RIG Contact & More Information�
	Comments and Accelerator Feedback

